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of the Creative Commons Attribution-ShareAlike 3.0 license.
Introduction to AtoM 2.0
AtoM, which stands for Access to Memory and is a web-based, free software application for standards-based archival description in a multilingual, multi-repository environment. It is designed to support ICA standards such as General International Standard Archival Description (ISAD[G]), International Standard Archival Authority Record for Corporate Bodies, Persons and Families (ISAAR[CPF]), International Standard for Describing Institutions with Archival Holdings (ISDIAH), and International Standard for Describing Functions (ISDF). ICA-AtoM allows you to describe your archival holdings in context. You will not create an archival description in isolation: you will link it to a description of a creator and a description of an archival institution, resulting in a complete account of what the records are, who created them and what archives they belong to. 

See https://www.accesstomemory.org/en/docs/2.0/user-manual/overview/intro/ for more information about AtoM. 
How these Tutorials Work
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Welcome to the AtoM Trail

ing Workshop

Hosted atthe University of Witwatersrand, October 21.23, 2013, the AtoM Training Workshop is designed to provide particpants with
hands-on experience using Atol open-source softwiare for onlin archival description and digitalcollections access. The records
incuded in this training Instance of AtoM have been generously provided by ARCHEION, the provincia portal to archival repositories and
resources in Ontario, Canada.

Atraining booidet has been created for this workshop and wil guide you and your partner through a number of key actvtes: creating
‘and editing archiva records, authority records and Institutional records; reating and editing taxonomies; managing user accounts and
performing adrministrative tasks within the database Interface.

1fyou need HELP, look atthe top right-hand corner of the screen and find the " con. Clck on the " and a drop-down menu gves you a
HELP option. Afternatively, you can ask your workshop Instructor for help.




This series consists of ten tutorials which are to be completed in the order listed:

1. Add/edit Groups 
2. User Permissions

   2.1   Information objects

   2.2   Actor                                                           

   2.3   Taxonomy

3. Static pages
4. Menus
5. Plugins

6. Site Settings

   6.1   Global
   6.2   Site information

   6.3   Default page elements

   6.4   Default template
   6.5   User Interface label

   6.6   I18n languages
   6.7   Security
7. Description updates
8. Visible Elements
9. Reports

10. Import / Export

For More Information and to Provide Feedback:
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If you would like more detailed instructions on using AtoM in general, you can consult the online user manual at https://www.accesstomemory.org/en/docs/2.0/. If you have any comments, questions or suggestions about the tutorials, the user manual or the software itself, please email AtoM Product Manager, Jessica Bushey jessica@artefactual.com

 HYPERLINK "mailto:jessica@artefactual.com.Questions"
. Questions about the software can be directed to the AtoM discussion list/ community forum at http://googlegroups.com/group/ica-atom-users.  
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Tutorial 1:  Add/ Edit Groups
In this tutorial you will learn how to manage Groups in AtoM 2.0. Groups are a powerful method of creating default permission settings that can be applied quickly to new Users. 
BEFORE YOU BEGIN:

Click the Log in link in the user menu (located in the upper right-hand corner of your screen). 
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In the Log in screen enter the following data:
Email enter: a

 HYPERLINK "mailto:admin@workshop.za"
dmin

 HYPERLINK "mailto:admin@workshop.za"
@workshop.za


Password enter: admin
Click the Log In button to complete

You are now logged-in as an Administrator. This means

you belong to the Administrator Group and have all the 

default permissions assigned to that group.

The header bar is different for Administrators. 

The most important menu is the Admin menu.  
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An Administrator can import & export digital objects, archival descriptions, authority records and taxonomies. The Administrator can read, edit, delete and publish all records in the system. The Administrator can control permissions of all users in the system and customize the application using the graphical user interface (GUI) provided.
In most Institutions there is only one Administrator and the processing archivists are given Editor status, which grants the functionality of an Administrator but restricts the ability to customize the application and control permissions for other users in the system.

User roles define levels of access to functions in AtoM, ranging from view-only access to full administrative rights. Your user account in AtoM is tied to one of five user roles, each representing a different level of access to the system. The user roles are defined by groups that an administrator can add and edit. In special circumstances, the Administrator may decide to create a user's account from scratch, in this case they start with the Authenticated group and build permissions onto it. 
Researcher/ Anonymous

A researcher is any user who is not logged in (sometimes called an unauthenticated user) and therefore has view-only access to the application. A researcher can search and browse descriptions (published archival descriptions, authority records and archival institutions).

Contributor
By default a contributor can search, browse, create, edit/update, view draft and export descriptions. The contributor cannot change the publication status of an information objects. A contributor can access the reference and master digital object.

Editor
By default an editor can search, browse, create, edit/update, view draft, delete and export descriptions and edit controlled vocabulary terms. An editor can also change the publication status of an information object. An editor can access the reference and the master digital object.

Translator
A translator can search and browse published descriptions and can translate user interface elements and database content. A translator should be able to view draft descriptions, but not edit them.

Administrator
An administrator can import, export, create, read, update, publish and delete any record in the system, can customize application to institution specific requirements, and can manage user accounts and profiles. Administrators can also create new user roles , set granular permissions for that role, and then assign or unassign users from the new role. 
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1.1 Click on the admin log-in and

select Profile from the options.
AtoM will load your user profile 

page and under User groups
you can see that it reads: 
authenticated

administrator

This means that you belong to 

two groups, authenticated and 

adminstrator. Any user that has 

a log-in is part of the authenticated

group.
1.2 The Administrator can view and edit access privileges of either a group or a user by navigating between the 4 different permissions tabs:

· Information objects permissions / archival description permissions

· Authority record permissions

· Taxonomy permissions

· Archival institution permissions

Each permission tab contains individual access privileges located under a header labeled as “Action”. Clicking on a specific permissions tab will direct you to the view page of the permission, where the access privilege for that specific user role will be dsiplayed under a heading labled “Permissions”. The Administrator can edit access privileges by switching from view mode to edit mode; simply click the “Edit” button in the button block. 
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1.3 Access privileges, also referred to as “Actions” will vary according to the permission type (i.e., the permissions tab) that has been selected.

Each tab displays the specific access privileges that can be maintained for users interacting with that specific entity (e.g., archival descriptions, authority records, terms, archival instititutions): 
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1.4 Click on each permission tab to view in the context of User admin profile. Notice that “admin” has inherited the permissions of the Administrator group, and that this group has been granted ALL privileges (i.e., Read, Create, Update, Delete, View draft, Publish, Access master and Acces reference) for information objects / archival descriptions. 
Click on the Edit button. AtoM loads the Edit archival description permissions of admin page. Now you can see a list of Actions that can be performed to grant or deny access to archival descriptions. You, as a member of the Administrator group, Inherit all the permissions of that group. 

It is possible to grant and deny permissions based on a single archival description or by a single archival institution. This is useful in a multi-repository setting, when you might have 10 archival institutions sharing the same AtoM database. 

Click on the Cancel button.

1.5  For the next exercise you need to be familiar with the Admin menu, located in the header bar at the top of the screen. The icon for the Admin menu is a set of gears. 
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Click on the Admin menu and select Groups from the list of options.AtoM will load a List groups page, which provides you with an overview of all the Groups in the system and the # of Members belonging to each group. 

Scenario: You have a group of students coming into the reading room on Friday and they want to look at a specific group of records. You want to limit their access to other holdings in the database to avoid confusion and keep the students focused. You decide to limit their ability to view holdings in any archival institution EXCEPT the City of Greater Sudbury Archives.
To add a new Group, click on the Add new button and enter the following data: 
· Name enter: University Student
· Description enter: This is a temporary Group that is visiting the Archives Reading Room to review Car Accident Photographs.
· Click the Create button. 
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AtoM loads the Group University Student profile page. If you Click through the different sets of permissions you will see that the University Student group inherits the permissions of authenticated; but that is all. You need to customize the permissions for this new group because it does not exist as a default group such as Editor or Contributor, which have customized permissions already loaded as defaults in the database.
1.6 The University Student Group is authenticated, so they can:

Read a published archival descirption;

Access the Reference copy of a digital object; 

Read an authority record;

Read terms that are part of taxonomies (e.g., subject access points);

Access the holdings of all archival institutions;

Access the archival instittution's record.

1.7 Now you must Grant or Deny permissions to customize the University Student Group. Once completed, you will be able to enter all the students as members of this group, then when the class is over, delete the group.

Start on the Group University Student profile page:

· Click on the Information object permissions

· Click on the Edit button

· Click on the Permissions by archival institution

· Click on the Add archival institution
· In the pop-up select from the list of archival institutions: Art Gallery of Ontario
· Click on the Submit button.

· Change the Permission to Read from Inherit to Deny

· Change the Permission to Access reference from Inherit to Deny

· Click on the Save button.

You have denied access to read the archival holdings of the Art Gallery of Ontario. 
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Repeat this exercise for all institutions in the database EXCEPT the City of Greater Sudbury Archives. That is the one archival institution that we want the students to have permission to read archival descriptions and permission to access reference digital objects. 

As the Administrator of the database, you can also change the default settings for all the Groups and customize them to suit your organizational structure. Simply Click on any of the existing default Groups and Edit their permissions. Whatever changes you make will affect every member that belongs to that Group. For the purposes of this workshop, please do not alter the Administrator group privileges. 

Tutorial 2:  User permissions
2.1 Information Objects & Archival repository
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In this tutorial you will learn how to manage user accounts, and control permissions associated with those accounts. Every user of the system who needs to be able to add, edit, or delete database content must have a user account. Only administrators can add new user accounts. 
2.1.1 Navigate to the header bar and locate the Admin menu. Click on the Admin menu icon, and select Users from the options. AtoM loads the List users page. To add a new User, Click the Add new button at the bottom of the page and enter the following data in the Basic Info area:
· Username enter: student01
· Email enter: aa@witsuniversity.za
· Password enter: student01
· Confirm password enter: student01
In the Access control area:

· User group select from the drop-down list: University Student
· Allowed languages select: English
· Click on the Create button
AtoM will load the User student01 profile page. 
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You can see that the student belongs to two groups:  Authenticated and University Student. The Repository affliations list the archival instittutions that have had the permissions customized. If you review the permissions, you will see that Information object permissions are restricted according to the Univeristy Student Group permissions you entered in the previous exercise. If you had 30 students, you can see that it is easier to create the University Student Group permissions first and then add students to the group, instead of creating permissions for each and every student. 
2.2  Actor
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Specific user permissions can also be set for Authority records in AtoM. In this exercise you will create a new user, called volunteer01, and assign them to the contributor group. To perform this exercise remember to log back into AtoM as the Administrator. 

· Follow steps in previous tutorial for creating a new user and assign them to the contributor group. 
· View the User volunteer01 profile page.
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2.2.1 After creating the new user, go to view the User volunteer01 profile page. At the top of the profile page, click on the Actor permissions tab, as you can see, they have been granted the permissions to create and update all authority records. This means that volunteer01 can access the edit authority record template in the database for any corporation, person or family. In the following exercise you are going to deny volunteer01 the permission to edit a specific authority record.

· Click on Actor permissions

· Click on Edit button

· Click on Add authority record
· Click on data entry field in pop-up and start to enter: Whiten (AtoM will suggest Whiten, Colette from the list of authority records, Select)

· Action Read enter: Grant
· Action Create enter: Deny
· Action Update enter: Deny
· Action Delete enter: Deny

· Click on the Save button

The authority record permissions for volunteer01 should look similar to below:
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2.2.2  To test the permission restrictions, log out and log in as volunteer01 and navigate to the Browse Authority records and locate the Colette Whiten authority record. You will be able to Read the record, but not Edit or Add new (no buttons available on the page).  Navigate to a different Authority record (e.g., Ayala Zacks Abramov) and your permissions are no-longer restricted, the buttons for Edit and Add new are visible and accessible to you.
2.3 Taxonomy
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Yesterday, you learned that in AtoM a taxonomy is a grouping of controlled-vocabulary terms used to generate value lists and access points. These value lists appear as the drop-downs in the AtoM interface that are used to present options to users. Administrators cannot create new taxonomies, the number and names of the taxonomies in AtoM are fixed and can only be altered by developers working directly with the code.You completed tutorials to manage taxonomies and to add a new term to a hierarchical taxonomy. You also learned that some taxonomies in AtoM are locked. In this exercise you will learn how edit a user's group affiliation and then grant and deny taxonomy permissions to users.
2.3.1 Navigate to the View User profile page for volunteer01. Click on the Edit button. This exercise requires you to change the volunteer01's user group from contributor to Editor.  The Contributor Group does not have access to altering Taxonomies, but the Editor Group does. In the Access control section, under User groups, there is a bullet next to contributor, if you hover over it, an “x” will appear. Click on the x. Now select Editor from the drop-down list.  Click on the Save button. 
[image: image24.png]Action
Read
Create
Update

Delete

Allarchival institution




· Select the Taxonomy permissions tab.
· Click on the Edit button. 
· Click on Permissions by taxonomy

· Click on the Add taxonomy hyperlink: enter P slowly in the pop-up data entry field (AtoM will prompt Places) Select Places.

· Click on the blue Submit button. 

· Action Create enter: Deny 

· Action Update enter: Deny
· Action Delete enter: Deny 

· Click on Save button.

2.3.2 Log out and then Log in as volunteer01.In this exercise you are going to test if the permissions change worked.

· Navigate to the List Places page
· Go to the Browse list and click on Places and AtoM will take you to the list of places page.

· Click on: London
· Click on Manage term button

AtoM shows you the Term page for London. You no-longer have the ability to edit, delete or add a new term. To test further, go to the Browse menu and select subjects:

· Click on Arts and culture
· Click on Manager term button

AtoM shows you the Term page for Arts and culture. You have the ability to edit, delete and add new terms through the buttons.

Remember to log out and log back in as an Adminstrator to start the next tutorial.

Tutorial 3:  Static pages
In this tutorial you will learn how to manage static pages: Welcome, About and Help. AtoM 2.0 ships with a default welcome message on the Home page and on the About page. Both Administrators and Editors have the permission to edit static pages. 
3.1 Navigate to the Admin menu and select Static pages from the options.
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3.2 On the List pages screen click on the Welcome hyperlink. Click on Edit. You can see that the text is exactly the same as what you see on the Welcome for the Workshop. Feel free to change this text to a different message. If you want to create formatting, use HTML  (e.g., <strong> </stong> for bold text etc. When you are finished, click the  Save button. 

You can edit any of the static pages in this manner. You can even include hyperlinks to URLs, but remember to use HTML (e.g., <a href>)

Tutorial 4:  Menus
In this tutorial you will learn how to manage Menus in AtoM. Menu customization is available to Administrators to assist them in creating, editing and deleting existing navigation menus. Some menus have a lock icon next to them, which means they cannot be deleted, but they can still be edited. 
4.1 Navigate to the Admin menu and select Menus from the options.

4.2 AtoM loads the Site menu list page, you will see 2 columns: Name and Label. All the Menu Names are hyperlinks. The Menu Names are grouped according to the menus available on the homepage.

For example, the Add menu can be seen here (on the left) as a screengrab from the homepage. But you can also see the corresponding listing of the Add menu in the Menu Names column (on the right). You can delete names from the menu list and those options will disappear from the AtoM interface. You can also change the labels and the menu labels will change in the AtoM interface.
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The menu list controls the Main menu (everything that appears in the Menu on the homepage, including drop-down list), Quick links (everything that appears in the Menu in the top-right corner of the homepage, including drop-down lists) and the Browse menu, which is located on the left-side of the AtoM homepage and also as a drop-down from the Browse tab in the header bar.

4.3 In the name column, click on browseInformationObjects hyperlink. AtoM loads the Edit menu page for browseinformationObjects.
· Label change from Archival descriptions to Resource descriptions.
· Click on the Save button.
AtoM changes the Label in the Menu list (below): 
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AtoM changes the Label in the User Interface (below): 
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4.4 To delete a menu that is not used in a multi-institutional portal, for example Accessions.

· Navigate to Site menu list.

· Locate the 2 Menus: addAccession and manageAccessions 

· Click on each hyperlink and delete. 

AtoM removes Accessions label from the interface, go to homepage to check.
4.5 Navigate back to the Site menu list page. Notice the grey arrows facing up and down next to many of the Menu Names? If you click on these arrows the Menu Names move up or down and the User Interface responds accordingly. For example, hover cursor over the grey arrow facing down next to browseFunctions. When you see a hand, click on the arrow, repeat this action until the Menu Name is below browseActors. Navigate to the Browse menu on the homepage and note that the order of the options has changed. 
Tutorial 5:  Plugins
In this tutorial you will learn how to manage Plugins. In general, the Administrator wants the majority of Plugins to be enabled so that their inherent functionality is provided through the User Interface. Administrators can only enable or disable a Plugin, they cannot delete them.
5.1  Navigate to the Admin menu and select Plugins from the options.

AtoM loads the List plugins page. The default is to have all plugins enabled except for qtSwordPlugin and qtOAIPlugin. The qtSwordPlugin is used when uploading DIPs (Dissemination Information Packages) to AtoM from Archivematica (digital preservation software) and qtOAIPlugin has been temporarily disabled because it was not working properly. 

All the Plugins should be enabled, unless the Administrator wants to restrict Users from entering data using that content standard/ template. For example, you cannot disable the sfIsadPlugin because that is the default content standard for archival description being used in the workshop version of AtoM. Later in the training manual you will learn about changing the default content standard, but in general ISAD(G) is going to be the Plugin that you use and so you cannot disable it. 

Typically, if a Plugin is disabled and a user tries to create an archival description using a disabled standard they will not be able to access the edit template and will get the response from AtoM below:
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Tutorial 6:  Site Settings
In this tutorial you will learn about managing the Site Settings. This tutorial is broken into sections: Global; Site information; Default page elements; Default template; User interface labels; I18n languages; and Security.  OAI Repository is temporarily inoperable and Job scheduling is a feature that requires access to the application code; however, in AtoM 2.1 an interface will be provided.
6.1 GLOBAL
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6.1.1 Navigate to the Admin menu and select Settings from the options. 

6.1.2 AtoM loads the Site Settings page. On the left-side of the screen is a menu with of the different sections, the first section in this tutorial is Global. If an Administrator changes something in the Global template, the changes are seen throughout the database – mostly in the way that data is entered or shown during archival processing. In many cases, the AtoM default settings have been selected to provide Users with the most support and the best interface.

· Application version let's you know what version of AtoM you are running
· Check for updates automatica notification if a new version of the software has been released.
· Maximum image width (pixels) - the default display size of uploaded digital objects 
· Results per page - the number of search results that will be displayed on results pages (E.g., search results, browse lists)

· Change this # to 10
· Click on the Save button

· Navigate to homepage and select Places from Browse menu. Notice that the results listed are 10 on each page. 
· Accession mask default format for automatic numbering of accessions [ YEAR MONTH DAY Incremental#] 
· Accession counter default is 0. This can be reset to any # as the starting counter.
· Reference code separator – this can be changed to “/” or “_” etc..
· Inherit reference code – Determines whether or not the reference code of an archival description is inherited by lower levels attached to that description. 
· Sort treeview (information object) - The ability to sort archival descriptions manually, by title, or by identifier -title in the treeview. Selecting "manual" means the descriptions will appear in the order in which they were entered into AtoM. Selecting "title" sorts the descriptions by title. Selecting "identifier - title" sorts the descriptions by identifier, then by title.
· Sort browser (users) – Option to set default sort order of browse lists to alphabetic or last updated for logged-in/authenticated users

· Change this to Alphabetic
· Click on the Save button

· Navigate to homepage and select Archival institutions from Browse menu. Notice that the sort option is now Alphabetic, instead of Most recent (i.e., last updated). 
· Sort browser (anonymous) – Option to set default sort order of browser lists to alphabetic or last updated for public users
· Multiple repositories – If multiple repositories are using AtoM this setting provides a filter in the advanced search to allow for limiting searches to a specific repository
· Default institution upload limit [GB] – This can be changed by the Administrator.
· Total space available for uploads – shows the space left for digital object storage
· Multi-page files - Whether or not uploading multi-page digital objects (e.g., pdfs) results in an archival description being generated for each page, or one archival description for one entire pdf. 
· Show tooltips – the Administrator can turn the tooltips on or off 

· Change to: No
· Click on the Save button.
· Navigate to the Add menu and select Archival descriptions from the options. Open any area and begin to type in a data entry field. You will notice that as you type, the ISAD(G) tooltips do not appear to help you along. This is because you turned off the tooltips in the Global settings page.
· Default publication status - Whether new archival descriptions are saved as draft or published by default. Many Administrators prefer to have new descriptions saved as draft so that they can review the work and approve it before posting it to the public. Remember that draft archival descriptions cannot be viewed by the general public. 

6.2 Site Information
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6.2.1 AtoM 2.0 introduces the ability for Administrators to edit the Site title and the Site description. Before, this was part of the site CSS and had to be customized by a developer. You can see the default workshop Site description that appears on in the top-left corner of the header bar. Have fun adding your own Site title and Site description. After you save them, scroll-up and look at the header to see how they look. Both are located in the top left-hand corner of the screen.
6.3 Default page elements
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6.3.1 Atom 2.0 introduces the ability to disable page elements, such as: Logo, Title and Description. If you changed the Site title and Site description in the prior exercise, you can experiment with disabling these elements. Scroll to the top of the screen and notice if they have been removed from view after you disable them.
6.4 Default template
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6.4.1 The default templates in AtoM for viewing and editing archival descriptions, authority records and archival repositories are based on International and National standards. AtoM 2.0 includes a number of different content standards such as ISAD(G), which is an ICA standard and DACS, which is a content standard developed by the Society of American Archivists for archival description of collections in the United States of America. 

An Administrator can select the default template for archival descriptions, authority records and archival institutions here in the settings page. The default for today's workshop is ISAD(G). 
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6.4.2 To see the differences between templates:

· select RAD from the drop-down list 
· Click on the Save button

· Navigate to Add menu and select Archival descriptions from the options

AtoM presents you with an archival description template based on RAD content standard, which has different area headings and elements than ISAD(G). To check, click on any area to open and begin entering data into a field. The tooltips (if enabled) will show you rules with the reference as RAD. 

· Return to settings and select ISAD(G) as the archival description default template. 

6.4.3 In AtoM 2.0 a new feature has been added that allows an Editor or Administrator to change the archival description content standard for a specific fonds, series, file or item. The change will not affect the default status of the archival description template.

· Navigate to the Browse menu and select Archival descriptions
· Select any archival description from the list of results (e.g., Burlington Spectator fonds)
· Click on the Edit button
· Open the Administration area and click on the Display standard drop-down. 

· Select Dublin Core
· Click on the Save button
You will notice that the archival description has changed and does not contain the same amount of information in it. That is because the content standard has changed from ISAD(G) to Dublin Core. This new feature allows different archival insitutions to use different archival description templates and to display different types of collections in a manner that is more suited to there contents (e.g., photographic collections of museum objects might be better served using Dublin Core). 

6.5 USER INTERFACE LABEL
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6.5.1 The Name column corresponds to the generic entity name that exists in the underlying application running AtoM. The Value column shows the AtoM default user interface labels. Changing the labels will affect the user interface. However, changing these labels will not automatically change the corresponding labels in the navigation menus – these must be changed in Settings->menus. 

· Informationobject: Archival description 
· actor: Authority record
· creator:  Creator
· repository: Archival institution 
· function: Function
· term: Term
· subject: Subject
· collection: Fonds
· holdings: Holdings
· place: Place
· name: Name
· digitalobject:  Digital object
· physicalobject: Physical storage
· mediatype: Media type
· materialtype: General material designation
· facetstitle: Narrow your results by:
6.6 I18n LANGUAGES
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6.6.1 Any user can change the current language in AtoM to one of the other supported languages by clicking on a language in the Language menu, located in the header bar with a Globe Icon. AtoM switches the user interafce to the perferred language, and:

· if a translation of the database content in the preferred language exists, AtoM switches to the translation;

· if no translated version exists, AtoM displays the description in its original source (typically English)
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In the Admin Settings, the I18n languages shows you the languages that are currently available in the AtoM workshop version. The current language in use in the database does not have an “x” next to it (e.g., English). There are four additional languages to English presented here. They correspond with the languages that are shown in the Language menu located in the header bar at the top-right corner of the screen.
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6.6.2 To add a language to AtoM using the I18n language interface:

· Select one from the drop-down menu, or start typing: Ital (and pick Italian)
· Click on the Add button
· The language will appear in the I18n languages in the Settings screen.
· Refresh your browser (place cursor in URL bar at end of URL and press enter)
· Navigate to the Language menu in the header bar and you will see that Italian has been added and is now available for users to select. 
· Click on Italian and see how AtoM reloads the interface to display in the Italian language.
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6.6.3 You will notice that there is a blue bar at the bottom of the screen, and in Italian it says “Traduzione Italiano”. This is the Translation bar. AtoM is a multilingual application, which means that both the user interface and the database content should be capable of existing in multiple languages. In this exercise we have switched the interface to Italian. If there were archival descriptions written in Italian (e.g., an Italian manuscript and the archival description are both in Italian) then these could be searched using Italian. 

Administrators can add and remove languages in AtoM. Administrator can assign users to the Translator group and ask them to translate the user interface into another language. AtoM does not perform the translation, but Translators can use the translation interface in AtoM to change content, the interface and static pages. 

· Select English from the language menu in the header bar when you are ready to move onto the next tutorial.

6.7 SECURITY PANEL
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6.7.1 Introduced in AtoM 2.0, the new Security features allow the Administrator to increase security by:

Limiting incoming requests for all Administrator functionality to an IP address or an IP range. 

For example:

· 192.168.0.1 

· 192.168.0.1-192.168.0.255 

Requiring SSL for Administrators.

Requiring stronger passwords by enhancing the login validation to at least 8 characters long, and containing characters from 3 of the following classes:  

1. Upper case letters

2. Lower case letters 

3. Numbers 

4. Special characters 
6.7.2 You can test the new security features in the Require strong passwords area:
· Click YES 
· Navigate to the Admin menu and select Users from the options
· Click on the Add new button

· Username enter: Visitor
· Email enter: visitor@archives.za
· Password enter: 1234
· Confirm password enter: 1234
· Under Access control join the University Student you created earlier today
· Click on the Create button
AtoM presents a warning related to the new security settings:

Tutorial 7:  DESCRIPTION UPDATES
In this tutorial you will learn about managing updates made to the database. The Description updates area of the Admin menu allows the Administrator to track new and updated resources, including: Archival descriptions, Authority records, Archival institutions, Terms, and Functions. 
7.1 Navigate to the Admin menu and select Description updates from the options.
AtoM loads the Browse newest addtions page. On the left-side of the screen there is a Type Facet drop-down that lets the Administrator choose what entity to review (e.g., arhival descriptions, authority records, terms etc.). Below is a Date Facet that lets the Administrator choose whether the results are going to be selected according to creation date, revision date or both. Last, the Publication Facet lets the Administrator choose whether the results are going to be selected according to published or draft status, or both/all. 

7.2 To test how the updates page works:
· Navigate to the Art Gallery of Ontario (Archival insititution record)
· Click on the Edit button

· Click open the Description area and in History enter: Established in 1901
· Click on the Save button

· Return to the Description updates page

· Select Archival institution from the Type Facet drop-down and from the Date Facet Click Revision

· Click on the Search button

AtoM reloads the Browse newest additions page, and the Art Gallery of Ontario is at the top of the list. You can click on the Name of the resource (e.g., Art Gallery of Ontario) to check that changes were made. This is the procedure many Administrators use for checking Archival descriptions, authority records, terms etc. created or updated by archivists and interns before approving them for publication status and online viewing. It is a step in their workflow for approval procedures. 

Experiment with changing other types of records and view the results in the Description updates page.

Tutorial 8:  VISIBLE ELEMENTS
In this tutorial you will learn about a new feature in AtoM 2.0, which is the ability to hide certain fields from Public viewers (e.g., Not logged-in Users). This feature came in response to Community feedback from archivists and Administrators that wanted to hide information from the Public, in some cases as a security feature (e.g. physical storage) and in other cases to make the archival descriptions easier for non-archivists to understand.
8.1 Navigate to the Admin menu and select Visible elements from the options.

AtoM loads the Visible elements page, it is divided into four areas: ISAD template, RAD template (not important for this workshop), Digital object metadata area, and Physical Storage. These are the four areas that have elements in them that an Administrator can hide from the public. Even when the elements are hidden from the public, a logged-in user (e.g., Editor, Contributor etc.) can still see the elements, which is necessary for their work. 

8.2 The ISAD visible elements list below reveals a selection of elements that can be de-selected (remove checkmark) and as a result they will be hidden from public view. None of these elements are mandatory in ISAD(G). AtoM default is to SHOW all elements.

8.3 To test this feature:
· Deselect : Immediate source of acquisition
· Deselect : Archivist notes
· Click on the Save button
· In the general search bar enter: Elstone (select the archival description, NOT the authority record)
· View the archival description for Robert Elstone fonds, note that there is information in the Immediate source of acquisition or transfer and there is an Archivist's note.
· Log-out
· In the general search bar enter: Elstone (select the archival description, NOT the authority record)
· View the archival description for Robert Elstone fonds, note that the information in the Immediate source of acquisition or transfer is NOT VISIBLE and the Archivist's note is NOT VISIBLE.
· Log back into AtoM as Admin 
8.4 Open the Digital object metadata area. As you can see, some of this information might be confusing for the Public to view, and might clutter an item-level description of a digital object as much of it is computer generated during the upload. Additionally, the original filename may be different from the title of the original photograph or title of the archival description, which could lead to confusion with patrons when requesting materials from the reference desk.

8.5 Open the Physical storage area. Some institutions choose to hide the physical storage location from the Public as a security measure. Fortunately, it can be hidden from the Public and still be available to Staff (with a log-in) for retrieval of materials.

Tutorial 9:  REPORTS / PRINTING
In AtoM 2.0 the option to print lists of files, items and physical storage locations. At this stage, the printing capacity is limited). The ability to print reports is a permission that Administrators and Editors have.
9.1 Printing Lists

In the general search bar enter: Accidents, and select File: Accidents. AtoM loads the View archival description page for the File 3 – Accidents. 

On the right-hand side of the screen there is “Reports” with a printer icon. 
· Click on Reports
· In the Reports page select: Item list (you can see the images are item-level descriptions in the treeview on the left-side of the screen)
· Click on Continue
· In the Item list – report criteria page select: Title and Yes

· Click on Continue
AtoM loads the Print preview page for the selected file list: 


You can see that there are a number of combinations that you can use to print & sort lists:


Tutorial 10:  IMPORT / EXPORT
In AtoM 2.0 the ability to import archival descriptions, authority records and terms using XML, CSV and SKOS is available through the interface for Administrators and Editors. Additionaly, the ability to export archival descriptions, authority records and terms using XML and SKOS is also available. 
10.1 IMPORT archival descriptions, authority records and taxonomies.

The following file types can be imported:
· EAD 2002 XML (hierarchical archival descriptions and associated authority records, archival institution descriptions and taxonomy terms)
· Dublin Core XML, MODS XML (archival descriptions and associated taxonomy terms)
· EAC (authority records)
· SKOS (hierarchical taxonomies)
· CSV (comma separated values)
This tutorial will focus on Import and Export of archival descriptions and authority records using EAD and EAC.

10.2 Import EAD of Archival Description for multi-level fonds with a creator.
· Navigate to the Import menu in the header bar.
· Select XML
· AtoM loads the Import XML file page

· Click on Choose file

· Select: canadian-environmental-law-association-fonds;ead.xml
· Click on Import button
· Ignore warnings and Click on View archival description button

AtoM loads the archival description page for a fonds-level description and its child-levels, and places the archival description Fonds S1000-Canadian Environmental Law Association fonds within the Wilfrid Laurier University Archives. The exchange standard being used to exchange the information in and out of the database is Encoded Archival Description (EAD). 

10.2.1 You can also Import a lower-level (e.g., series) into a higher-level (e.g., fonds) directly in the view archival description page.
· Navigate to the archival description for the Cooke fonds
· View the archival description page at the fonds level (make sure you click on the ellipses underneath the treeview so you can see all 10 Series)


You will see that on the right-hand side the section Import 
· Click on the XML hyperlink
· AtoM loads the Import a XML file page

· Click on Choose file

· Select: artifacts-2;ead.xml
· Click on Import button
· Ignore warnings and Click on View archival description button
AtoM loads the Series 11- Artifacts page and 

if you look on the left-hand side of the screen, 

you will see the new imported series in the 

correct place in the treeview. 

10.3 Import EAC of Authority Record
· Navigate to the Import menu in the header bar.
· Select XML
· AtoM loads the Import XML file page

· Click on Choose file

· Select: david-suzuki;eac.xml
· Click on Import button

· Click on View Authority record button

AtoM loads the authority record page for a David Suzuki. Notice that a related entity is the Canadian Environmental Law Association, the creator of the Fonds that you just imported. 

10.4 Export an Archival Description as EAD
· Navigate to the archival description for the Cooke fonds
· View page at fonds-level, notice on the right-hand side of the page there is a section labled Export and underneath click on EAD 2002.XML

Your browser window will look like this:

· In your browser, select File -> Save Page as

· You can save it to the desktop of your computer: cooke-fonds;ead.xml
· Now press the back arrow on your browser to return to AtoM. You have just saved an EAD file to the desktop that could be imported back into AtoM if you want, but before you import it you must delete the original Cooke fonds from the AtoM database. Simply click on the Delete button and then Import the EAD file back into AtoM the way you did for the first exercise in 10.2.
10.5 Export an Authority Record as EAC

· Navigate to the Authority record for S. (Shieky) Brownstone
· View the authority record page 
· Click on EAC hyperlink located under Export on the right-hand side of the screen


Your browser window will look like this:

· In your browser, select File -> Save Page as

· You can save it to the desktop of your computer: brownstone-s-shieky;eac.xml
· Now press the back arrow on your browser to return to AtoM. You have just saved an EAC file to the desktop that could be imported back into AtoM if you want, but before you import it you must delete the original Brownstone authority record from the AtoM database. Simply click on the Delete button and then Import the EAC file back into AtoM the way you did for the first exercise in 10.3.
Congratulations! 

You have completed the Administrator tutorials. 
If you have any questions this is the time to ask them. The AtoM application has grown to be a very complex and powerful tool. Not all the features could be covered in this workshop; but, the Instructor can answer any questions you might have about AtoM so please feel free to ask them. Additionally, every archival organization is different and some choose to remove certain features from the software (e.g., accessions or functions), remember that an Administrator can customize the software to suit their specific organizational needs and workflow processes. 
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